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NET CONFERENCING verizon

Reserved Net Conference with
Cisco WebEx Event Center
Frequently Asked Questions

This document addresses how to use Reserved Net Conference with Cisco WebEx Event Center service — from scheduling a
Reservation, to confirming or changing a reservation and ultimately to hosting an event.

1. How do | obtain a Manage My Meetings account?

Follow the steps below to register and begin using today!
e Goto http://e-meetings.verizonbusiness.com
In the top right corner of the page, select Need to Register?
Click on Register (Audio/Net/Video Customers).
Click Yes to proceed.
Create your leader profile:
o Select a login name
Select a password or let the system create one for you
Set a security question and answer
Complete the fields on the page with your information details
Authorization code: your conference administrator will provide this to you
Click Proceed
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2. How do | schedule a call?

You will need to schedule the Reserved Net conference with a Premier or Standard audio conference, via either
the Conferencing Scheduling Assistant (CSA) tool or by calling Reservations.

e Conferencing Scheduling Assistant:
o Go to http://fe-meetings.verizonbusiness.com
0 Goto Leader Tools and click on Conferencing Scheduling Assistant

o Loglin
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o  Follow the instructions within Conferencing Scheduling Assistant

Conference Scheduling Assistant

Current Conferences Completed / Cancelled

From:[08/27/2015  |7F] Te:[0827/2015  |7H W] Audio

Start a Conference Leader Confirmation Meeting Phone Participant Leader
Date Type Name Number Name Numberi(s) Passcode Passcode
(@] Aug-31-2015 Premier KATE PARKER Multiple Mumbsrs ~ TEST 12386976
0600PMCT  Recurring 5004444 Auiie
110 10f1

m Modify Conference Duplicate Conference Cancel Conference

Conferences with ' represent video conferences

Orders with their Conference Type displayed in blue text are part of a recurring series.

Orders part of recurring series, displayed in green text color are updated after recurring series creation

Please Mote: If your order is not listed, you may need fo reload the page. Please click the "Refresh List" icon at the lop of this page.

e Calling Reservations
o Goto: https://fe-meetings.verizonbusiness.com/global/en/globalResNumbers.php
o Click on Contact Us
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Reservations and Service
To speak to a reservation or customer service specialist, please contact us.

3. Confirmation Email

e Once the leader schedules the meeting, they will receive an email confirmation with the details of the event
which they can share with their participants.

e  See higlighted sections below for the Reserved NetConference portion of the email confirmation.

e  Sample Reserved Net Email Confirmation:
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WebEx '™ Net Conference Access Information:

WebEx Required Download:

To use WebEx for your operat alike must have the
WebEx Evorl Manager installed pror to goining, To davwnboad Ihe Event Monages, chick on

[mmm Under the WebEx Event Manager heading select the downlead that matches your operating

ted eonf; and

For Leadars:
A Luacer can indiate the event dineclly via Marage My Meetings wsing thir Loges and Password. Upoan
, select the ‘Reserved Audio Calls’ tab and click on the START icon to launch your Nat Conferance

are your documens

The Net portien of your call can be accessed 30 minutes prior 1o its scheduled start time.

If you have questians about shadng your documents, please click hore ar contact Reservations

For Panicipants:

: hittps:{fe-meeti
Caonference number FAWXWSI25073
Audience passcode: 5621823

Panticipants can join the event directly at:

hitps fe meeting Dbt WKW P - SEHE3R ¢

NOTE  The replay of this eonference i5 availabile in an Advanced Reeording Fde (ARF) format and
requires the WebEx Recording Player 1o be viewsd. The Player is avadable frem the Conferencing ponal
“Nut Conlurenong Pluging

under Leader Tools 3
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1. Enter your Manage My Meetings Login and Password
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3. Salect the repont you wish to display — Met Conferance - and select View Report’
4, You coan then downdoad or prml your repert
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‘when jaining conference.
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Q8A Het Conference
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4. Do I need to download software to my PC to join the Reserved Net Conference?

Yes, as you join a Reserved Net Conference, the Event Center Meeting Manager software will load on your PC.

If you

wish to download the software prior to joining the call please go to the Plug-Ins page of e-meetings to

download the Event Center Meeting Manager software. You may also test that it loaded correctly by clicking on
the Setup link under the Event Center section.

Note: |

f you do not have administrative rights to your PC, the Event Center Meeting Manager software will need to be

downloaded by your company’s IT organization. They may obtain access to the software on the Plug-Ins page.

Go to the Plug-Ins page on e-meetings:
o0 https://fe-meetings.verizonbusiness.com/emeet/join/src/plugins_em.php?langKey=en
Scroll down to the WebEx Event Manager under the WebEx Plug-Ins section

Choose which version of the Event Center software to load on your PC based on your operating system

Click Setup which will launch you into a test Event Center session if the software load was successful

WebEx Event Manager

To start or join an event you will need to download, install, and configure the WebEx Event
Manager. The first time you join or start an event, the Event Manager will automatically be
installed; however you can manually download it here.

MNotes:

o If you are using a non-Windows or Macintosh operating system or browser other than
Internet Explorer or Firefox, a Java Client will be downloaded automatically when you join an
event. For more information, go to the FAQs.

You must have administrator privileges on your computer to use this installer.

(=]

Download the installer for your operating system:

- Event Manager for Internet Explorer in Windows
N Event Manager for Firefox or Chrome browsers in Windows
] Event Center application for Mac 0S5 X (Intel)

=]

Set up
Although WebEx Event Center will automatically be set up when you host/join a mesting,

you can save time by setting up WebEx Event Center, on Windows or Mac, before the
meeting.

5. Where will | access the event?

. Email invitation:

o

o

Participants:

e The Reserved Net Confirmation email will be sent to the leader of the event who will forward
the invitation to all participants. The participant link to the Reserved Net meeting will be
included in that invitation. Audio details will also be included for participants to dial into the
audio bridge.

Leaders:

e Leaders will log into their Manage My Meetings account to start their Reserved Net for Cisco
WebEx Event Center meeting.

e The Reserved Net meetings will be listed under the tab for Reserved Calls. See instructions
under the next e-meetings sub-bullet.

e e-meetings: The meeting link will also be listed on the leader's Manage My Meetings account on the
Reserved Calls tab

(o]
o

o

Go to http://e-meetings.verizonbusiness.com

Enter your login and password. (Note: If you do not have a Manage My Meetings login and password,
Click on the Need to Register link and simply follow the instructions.)

Select the Reserved Calls tab.

Locate the appropriate confirmation number for the conference.
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o Select the arrow icon to initiate the conference.

Note: You will need access to Manage My Meetings to use Reserved Net Conference with Cisco WebEx Event
Center. If you do not have access to Manage My Meeting, you should continue to use Reserved Net Conference
with Microsoft Live Meeting for the short term.

Is there a cancellation policy?

Yes, Reserved Net calls may be cancelled up to 30 minutes before the event without incurring a cancellation fee.
If canceled within 30 minutes of the scheduled start time, a cancellation fee may be assessed.

Can my call be recorded?

e Yes, you may request the call to be recorded. For each call that is recorded, there is a setup fee that
includes storage of the recording for 30 days. If you'd like to maintain the availability of the recording after
this time, there is extra charge for each additional 30 day period.

e The Net Replay will be available after the call via the link included in the Reserved Net email confirmation.

e You may also request an FTP File Download of the recording for an additional fee. The link to the FTP File
download will be included in an email sent to you after your call.

Is software required to view the replay of the meeting?

e Yes, the replay and the FTP file Download are both available in an Advanced Recording File (ARF) format
and require the WebEx Recording Player to be viewed. The Player is available from the Conferencing portal
under Leader Tools and then Net Conferencing Plug-Ins.
https://lwww.mymeetings.com/emeet/join/src/plugins_mm.php?sigKkey=mymeetings

How do | retrieve the recorded file from my Reserved Net call?

e  The host of the call will receive the below email
e  The “From” field will come from the person who hosted the meeting.

Co

Subject: Instructions for downloading the WebEx FTP recording "PWX\W5166010-20150522 0443-1"
Please follow the instructions below to download the FTP recording from your recent WebEx Reserved MNet EEJ
conference.
PWXW5166010-20150822 0448-1
August 22, 2015, 12:48 pm Taipei Time
5 mins
DOWNLOAD INSTRUCTIONS:
1. Click on the link below, or if your email program does not allow linking, copy and paste the link into the address
field of your Internet browser: L
https://resnetl.webex.com/resnetl/lsr.php?RCID=b2ef03ad6f4ef54f5b3ed11b410aa05¢c
2. Once you have been redirected to the Download page, select the "Download” button.
3. When given the option to "Open” or "Save” the file; select the arrow next to the "Save” button, then select "Save
As".
4. Once the "Save As" window appears, choose the location where you'd like to save the FTP file and select the
"Save" button.
** Please download your FTP recording within 30 days of the date of this email, after that time it will be deleted
off the server and no recording backup is maintained past this time frame. **
If you need assistance, please contact us at the following email address: conf@mymeetings.com
-

I:l MoRepliesPlease@mymeetings.com I:H:l A

e  Click the link provided in the email as seen in the below screen shot.
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[ want to share the following WebEx recording with you. Click the link below to play it:

https://resnet-dev.webex. com/resnet-dev/lsr. php?
AT =pb&SP=ECArD=539;

e You will be redirected to a page as seen in the below screen shot, that will provide them with the ability to
Download the recording.

Recording Information
Topie: PA-20130710 16131
Recording dote: Wednesday, July 10. 2013 11:13 am
Cantral Daylight Time (Chicags, GMT.05.00)
Panelist Information:
Duration: 5 minutes
Description:

e After selecting “Download” the following page will appear and you will have the ability to “Save” the file in a
location of their choosing.

e - ‘) https://resnetl we.. 2 ~ @ & UDownload file
File Edit View Favorites Tools Help
ﬁ = - [ Eéu ~ Page~ GSafety~ Tools~= 'Q'v
Download file:PWXW4925204-20150826 1356-1.arf
The recording file is ready for downloading now.

Note: The WebEx ARF player is required to playback the recording. Download ARF player

Close Window

If you do not have the ARF player installed,
you may click the “download” link to install it.

©2015 MyMeetings
Privacy | Terms of Service | Reguest information about WebEx services

PWXW4925204-20150826 1356-1.arf (41.6 MB) ntalwss.webex.com

Open Save - Cancel

10. How can | convert the recorded file to a different format?

e  The FTP recording will be downloaded in an Advanced Recording File (ARF) format that is WebEx
proprietary software which will require the user to install the WebEx Player to view the recording.

e You may convert the recording to one of the following formats:
o WMV —Windows Media Video
0 .SWF - Macromedia Flash Format
0 .MP4 - MPEG Audio Layer

e This is a Real Time conversion process: A presentation with a duration of 1 hour and 15 minutes will take 1
hour and 15 minutes to convert.

In the Network Recording Player select File
e Select Convert Format



e  Select either WMV, SWF or MP4

View Info Help

Ctrl+0 Iez | Date: Wednesday, August 26, 2015 | Time

WY (Windows Media)...
SWF (Flash)...
P4 (MPEG-4]...

\iednesday, August 26, 2015
2:158 AM, Local Time (GMT -06:00)
Conference Admin

e  The Convert to window appears.
e Select OK to proceed to start the conversion.

T Convert Formal to WY (Windows Media)

Freview Layout |
Wideo Codec
Video Codec: | Windows Medsa Video 9 I=]
A Codec
Audio Codec: | Windows Media Audic 9.2 [~]
Conversion Start Time

It may take a subctantial amount of time and vour computer rescurces bo convert this file,
when do you plan to start the conversion?

" Corvest now
" Corwert at a scheduled bime:

Pea [ |20 [=]s2 J2] |15 s [

The conversion requires Windows Media Player 9.0 or abave,

The below message will appear.
Select OK and this message will disappear, leaving the conversion process to run in the back ground as you
work on other things.



Metwork Recording Player IE

Conversion of "Other Teleconference Tesk-20110815 1542-1,arf" to "Other Teleconference Test-201 10515 1542-1 . wmw",
Double-click the Conversion Manager icon on the taskbar of wour deskiop ko view information about and manage scheduled
recarding conversions,

e You may check the conversion progress by placing your mouse over the following icon in at bottom-right of
your screen (system tray):

converking: 10% converted

LR

11. Is operator assistance available to me during my conference?

e Before the event:
o Yes, operator assisted services are listed under Net Feature Support on the scheduling systems.
=  This feature allows you to request a Net Conferencing Specialist to provide event support
services during a Net Conferencing session on your behalf.
= An additional charge applies per session per Event Support service. Examples of Event
Support Services include:
e Video playback: Assistance and coordination of the video playback to allow the
audio to play through the audio conference.
e Advancing slides: Advancement of the slides on behalf of the leader
e Closed Captioning: Coordination of closed captioning for the event

e During the event:
0 The operator will attend a Premier Level Audio conference for the entire time to attend to Q&A, or
address issues during the call.
o0 The leader will enter *0 to have the operator rejoin the audio conference to attend to an issue.

e After the event:
0 Charges for Operator Hosting services will be included on your invoice for the call.
12. How many participants may | have for my event?

e Upto 3,000 participants (including the presenter and the event operator) are supported on Reserved Net
Conference for Cisco WebEx Event Center.

13. What is the WebEx Event Center Leader Console?

The console is an easy interface that makes controlling a meeting very intuitive. Leaders can select to have
only those windows that are most important to them open during the meeting, showing the participants, chat,
notes, or video. Simple tabs make it easy to flip from presentation to presentation.
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14. How do | Share Content in the event?
A best practice for presenting content in a WebEx Event Center session is to use File Share.

() Cisco WebEx Event Center
File Edit View Communicate Participant Event Help
My Screen Ctri+Alt+D

QU":I‘S File (Including Video).. I

Application 3
—l—r- Whiteboard  Ctrl+Alt+N
Z

Web Content...

Web Browser...
Even Multimedia...

My Event Window

@® Record End Event

File sharing is ideal for presenting information that you do not need to edit during the event, such as a video or
slide presentation. Participants can view shared files in their content viewers without the need for the application
with which it was created. They may view a media file, such as a video, without the need for special software or
hardware. They can also view any animation and transition effects on shared Microsoft ®PowerPoint ®slides.
After an event starts, you can open a presentation or document to share. You do not need to select it or loadit
before the event. However a best practice is to arrive to the call about 15 minutes before the call to initiate the
File Share for any documents you intend to share during the call. They will be arranged in folder across the top of
your meeting for easy selection during the call.

While sharing a file, you can:
e  Draw on the screen
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Use a pointer to emphasize text or graphics

Print it

Display it at various magnifications, in miniature (thumbnails), and in a full-screen view
Synchronize all participants' displays with the display in your content viewer

Save it to a file

At any time during a meeting, you can grant participants privileges that allow them to annotate, save, print, and
display different views of shared content.

Sharing a file
You can share a file, such as a document, presentation, or video that resides on your computer. Participants view
the shared file in their content viewers.

To share a document or presentation:
e  On the Share menu, choose File (Including video). The Share File dialog box appears.
e  Select the file that you want to share.
e  Click Open.

The shared file appears in the content viewer.

Tips for sharing files:
These tips can help you share files more effectively.
e Toimport slide presentations quickly:

e Limit the number of animations and slide transitions.

e  Minimize the number of screen shots that you add to slides, especially bitmap graphics. Bitmaps
do not compress well.

e Toimprove the speed at which shared pages or slides appear in participant content viewers, save
the document or presentation as a .ucf (Universal Communications Format) file before the event
starts. Then share the .ucf file instead of the document or presentation itself.

e You can annotate shared presentations or documents in the content viewer; however, you cannot
edit them. If you want to edit shared information, you can use application sharing instead.

To save time during an event, begin sharing the document or presentation before the event's starting time. That
way, after participants join the event, they can begin viewing your presentation.

Choosing an import mode for presentation sharing:
For Microsoft Windows® users only

Before you share a presentation, you can choose one of the following import modes:

e Universal Communications Format (UCF)-The default mode. Allows you to display animations and slide
transitions in Microsoft PowerPoint presentations. In the UCF mode, Event Manager imports presentations
more quickly than it does in the printer driver mode. However, pages or slides may not appear consistently in
Event Manager across platforms.

e Printer driver-Displays shared presentations as they appear when you print them, providing a consistent
appearance of pages and slides in Event Manager across platforms. However, this mode does not support
animations or slide transitions. In this mode, the first page or slide may appear quickly, but the total import
time for all pages or slides is usually longer than it is in the UCF mode.

Note: Changing the import mode does not affect any presentations that you are currently sharing. To apply a
new import mode to a shared presentation, you most close it first, and then share it again.

To choose an import mode for shared presentations:
¢ Inthe Event window, on the Event menu, choose Options. The Event Options dialog box appears, with

the Options tab selected by default.
e  Click the Import Mode tab.



Q Event Options X

Communications True Color Mode

Import Mode

To ensure good-quality imaging for document and presentation
sharing, select the appropriate import mode.

Import mode:

O Universal Communications Format
Supports animations and slide transitions in shared Microsoft(R)
PowerPoint(R) presentations

Printer driver

Provides better cross-platform imaging, but displays presentations
without animations and slide transitions

0K Cancel

e  Select either Universal Communications Format or Printer driver.

Closing shared files:
You can close any files that you are sharing in your content viewer.

To close a shared file:
. In the content viewer, select the tab for the file that you want to close.
e  On the File menu, choose Close.

If you have not yet saved any annotations that you made on the document or presentation, a message appears,
allowing you to save it.

15. What file types are supported for sharing in Cisco WebEx?

Please see below tor a listing ot supported tile types:

Media Object Supported Media Formats E:felxsainl:ss Required Player
WebExz Recording VWebEy Recording Format (WRFY et Built in
fudio Windows Media Audio SWma Windows Media Player
&dvanced Streaming Format asf
sdio for Windows (WA WA
ﬁjﬂ;l&g&n{ﬁggﬁent Digital mid, .midi
Macintosh AIFF Resource Aif, .aiff
MP3 (MPEG Audio Layer) Mmp2, mpy2, .mp3
UMIx Audio .au
Sound (SHDY snd,
Audio Interchange File aif, .aiff, alfc
Video Windows Media Wideo RnA Windows Media Player

&dvanced Streaming Format Asf
Audioffiden Interleave (&AW =T
Moving Picture Experts Group  .mpd, .mpedg, mly,

(MPEG) R, Re.
Video - QuickTime P Apple QuickTime Player
movies Apple QuickTime moy, ot for Windows
Flash movies and Macromedia Flash format e Macraomedia Flash Player

interactive Flash

Any LURL on the Intemet or your |For example, fitm,

Web page private intranet asp, . Intemet Explorer

16. How do | share a video as a Presentation or Document?

e In the meeting window, go to the Share menu, then select File (Including Video)

11
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17.

18.

e  The 'Share Document' window appears.
¢ Navigate to and select the file you would like to share in the meeting.
e  Click Open.

Notes:
e Avideo file must buffer before it can play back.
e Itis recommended that the video file being shared is no larger than 5mb.

WebEx supports the following video formats as a Presentation or Document share:
flv (FLV files using the VP6 codec are not supported on SP22 or newer sites)
.swf

.asf

wmv

.avi

-mpg

.mpeg

.m1lv

.mpa

.mpe

wm

What is the Maximum Recommended Size for a Shared PowerPoint File?

For best results when sharing a PowerPoint file, refer to the following guidelines:

e Do not include more than 20 to 30 slides in one presentation file. If you want to share more slides,
create a separate presentation file for each set of 20 to 30 slides.

e  Keep the size of the presentation file to no more than 5 MB.

e Itis recommended to not share embedded media objects that are larger than 5MB.

Note: You may exceed the 5mb recommendation if the service type used has the ability to stream video files.

What is the best method to share a video file in a WebEx meeting?
Follow the steps below to stream a video file in a WebEx meeting:

e  On the Quick Start, click the Share File button.

. If the Quick Start is not visible, go to the Share menu, then select File (Including Video)

¢ Navigate to and select the video file you would like to share and then click the Open button.
e  The video will begin playing in the WebEx meeting.

Notes:
e Recommended for sharing video files stored on your computer or a network location.
e  Starts playing for attendees instantly.

The following file types are supported with streaming video sharing:

WMV
WMA
WAV
.MP3
ASF
AVI
.MPG
.MPEG
.MOV
.FLV (Video codec must be H.264, files using the VP6 codec will not playback properly)
F4Vv
.QT*
.MP4*



*The computer sharing the video must be able to playback the file locally.

19. How do | share a video from a web site or web page?
Follow the steps below to share Web Content:

In the meeting window, go to the Share menu and then choose Web Content....

The 'Share Web Contents' window appears.

In the Address box, enter the address, or URL, at which the content resides.

Note: If you have previously shared the content, select it in the drop-down list.

In the Type: drop-down menu, select the type of Web content that you want to share.
Click the OK button.

e Tip: You can copy a URL from any source, such as another browser window, and then paste it in the
Address box.

Notes:
e  The video file must be on a publicly accessible web address and not password protected.
e Can also be used to display a web page that contains a video, such as YouTube.

20. Which Webcams are supported?

e  Camera hot-plugging is supported with WebEx HD/HQ video. This means cameras can be plugged in and
detected by WebEx during a live meeting.

e |P or web-based cameras are not supported by WebEXx. Virtual webcams such as YouCam, ManyCam and
WebCamSplitter are also not supported.

e  Webcams listed in Microsoft's Hardware Compatibility List (HCL) should work with any WebEx product that
supports video conferencing. If your device is not listed, it may not work with WebEXx.

e Hi-Definition video is not yet supported on Event Center.

Cameras compatible with High Quality Video:

Manufacturer |Model

e Cisco VT Cameralll
e Cisco VT Camera lll

Cisco

Tandberg

Tandberg Precision HD

Logitech Quick Cam Pro 9000
Logitech Quick Cam Orbit AF
Logitech Quick Cam C905
Logitech Quick Cam S7500
Logitech HD Pro Webcam C910

Microsoft LifeCam HD
Microsoft LifeCam VX-1000
Microsoft LifeCam Cinema
Microsoft LifeCam VX-6000
Microsoft LifeCam NX-6000
Microsoft LifeCam VX-3000

Logitech

Microsoft

Cameras compatible with Standard Quality video:

Most PC-compatible cameras should work with WebEx. The following cameras were tested by WebEXx:

Cisco VT Camera Il e  Logitech QuickCam for Notebooks Pro
Creative WebCam Notebook Logitech QuickCam Zoom

Creative WebCam NX Ultra Logitech QuickCam Express

Creative WebCam PRO Logitech ClickSmart 310
EzpmocsEZCam USB Il Logitech QuickCam pro 4000
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21.

22.

23.

24.

25.

Logitech QuickCam Messenger e SUMSUNG S-1288
Aiptek VGA+ e Microsoft LifeCam NX-6000
SUMSUNG S-1298

Who can share their Webcam in an event?

Only the host, presenter or a panelist may broadcast their webcam video in an event.
By default, panelists cannot broadcast video in an event. The host must allow a panelist to send video

How Many Video Cameras can be displayed?

The number of video cameras that can be displayed in a session of Event Center is one.

How does a panelist send video in an event?

The host of the call must follow the steps below to allow a panelist to send video:

In the Participant panel, place your mouse over the large video window, then click the E button.
The 'Panelist Video Options' window appears.

Go to the Allow to Send Video tab.

Check the boxes of the panelists you would like to send video, then click the OK button.

e The selected panelists may now send video by clicking the button.

What are the bandwidth requirements for in-meeting video?

WebEXx generally recommends network bandwidth above 1Mbps per participant. A dual-core PC @ 2.0 GHz w/
1GB ram should be used. The minimum network bandwidth to view video should be above 320Kbps per
participant. Standard WebEXx video generally requires bandwidth between 90-130Kbps per video participant at the
default configuration, which is QCIF resolution (176 x144 pixel) at 15fps.

Bandwidth requirements for High Quality (HQ) video are as follows:

e High Quality - 360p (640x360) - Up to 1.5 Mbps of your internet connection will be used when sending video

e  Standard Quality - 180p (320x180) - Up to .5 Mbps of your internet connection will be used when sending
video.

Note: The figures above are only for webcam video and do not include any other in-meeting activities. You will

need to additional bandwidth to use desktop sharing, integrated VolP, etc.

Q&A

Questions can be answered publicly or privately in a Q&A session.

Providing a public answer to a question:

e Onyour Q&A panel, go to the tab you received the question in, and click on the question.
e A number will be displayed in the tab the question was received in.

¥ Q&A X

Al (1)

Q: This is a question

Public Response

Send Send Privately...

scnd

e  Type your answer into the text box and click the Send button or press enter.
e  The answer will appear on all panelists' and attendees' Q&A panel.

Providing a private answer to a question:



¢ Go to the tab the question was received in, and click on the question.

v Q&A X

All (1)

Q: This is a question

Private Response

Send Send Privately...

e  Type your response, and click the Send Privately... button.
e«  The answer will only be sent to the attendee that asked the question.

Responding to questions answered verbally:
e Right-click on the question in the Q&A panel.
e Select Answered Verbally from the context menu.

Answering indicator
When a panelist is typing an answer to a question that hasn't been responded to yet, an in-progress indicator will
display below the question for all participants. See the example below:

v QRA

b

All[1) My Q&A (1)

1 This is a guestion
This guestion is being answered...

26. Saving a Q&A session

At any time during a session, you can save the questions and answers on the All tab on your Q & A panel to a .txt
or .csv file.

In the Session window, on the File menu, choose Save>Questions and Answers.

The Save Questions and Answers As dialog box appears.

Choose a location at which to save the file.

Type a name for the file.

In the Save as type box, select TextFiles(*.txt) or CSV (comma-separated/comma-delimited values).

Click Save.

27. Who can present during the Event?

Your event production team can be broken down into the following roles:

Role Description

Host The participant who schedules, starts, manages, and ends the event and designates the presenter,
panelists, and polling coordinator.

The event host initially is the presenter. After the invited panelists join the event, the host can pass the
presenter control to any of the panelists at anytime during the event.

Presenter
The participant, with the presenter control symbol ,who is responsible for sharing and presenting
information during the event.

Panelist A participant who is primarily responsible for assisting the presenter and participating in presentation.

Attendee A participant who mainly listens or watches and does not present information during the event.
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28. What can each role perform during the event?
e Hosts can do the following:
A host is responsible for coordinating and controlling an event. Only one person can be an event host at
atime.
o0  Schedule and start an event
Start and end a practice session among the panelists
Invite attendees to a scheduled event
Invite attendees to an event in progress
Grant privileges to attendees or panelists during an event
Designate a presenter
Assign the host role to another panelist, and reclaim the host role
Answer attendees' questions during a question-and-answer (Q & A) session
Restrict access to an event
Specify or edit a greeting or message for attendees during an event
Act as poll coordinator to start a poll
Pass the poll coordinator role to another panelist
Record an event
o Endanevent
Note: Once an event starts, the host is initially the presenter as well. The host can then designate another
participant to be the presenter.

OO0O0O0OO0OO0OO0OOO0OOOO

e Presenter can do the following:
An event host can designate any attendee as a presenter. A presenter is responsible for providing
content during an event.
Documents, presentations, and whiteboards
Save documents, presentations, and whiteboards in the content viewer
Share applications, Web browsers, and desktops
Share multimedia Web content
Take a poll if the host passes the poll coordinator role to the presenter
Save a poll questionnaire and poll results to a file
Answer attendees' questions during a question-and-answer (Q & A) session
Send text responses to attendees' questions on the Q & A tab
Participate in a practice session
Participate in a chat
Save chat messages to a file
Save a Q & A session to a file
Record an event

O0O0O0O0OO0OO0OO0OOOO0OOO

e Panelists can do the following:
A host can designate any attendee as a panelist during an event. A panelist is a participant who is
primarily responsible for assisting the presenter and participating in presentation. Any number of
attendees can be panelists.

O Participate in discussions to which other attendees listen

O Respond to public and private chat messages

O  Annotate shared documents

O Start a poll if the host passes the poll coordinator role to the panelist

O View and answer attendees' questions in a Q & A session

O View poll results

O Annotate shared applications, Web browsers, and desktops, if the presenter grants annotation control to
the panelist

O Participate in a practice session

O Save chat messages to a file

O Download files that the presenter publishes

O View live video that the presenter sends

O View feedback

O Record an event

e Attendees can do the following:
An event attendee participates in an event, but generally does not present information.
View shared documents, presentations, and whiteboards in the content viewer
View shared applications, Web browsers, and desktops
View shared multimedia Web content
Participate in a poll
Participate in a chat
Save chat messages to a file
Download files that the presenter publishes
View live video that the presenter sends

O0OO0OO0OO0O0OO0OO0
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e If the event host or presenter grants the appropriate privileges to attendees, an attendee can also:
Annotate shared documents and presentations in the content viewer

Write and draw on shared whiteboards in the content viewer

Save documents, presentations, and whiteboards in the content viewer

Annotate shared applications, Web browsers, or desktops, if the presenter grants annotation control to
the attendee

Copy and paste pages, slides, and whiteboards in the content viewer

Display different views of pages, slides, and whiteboards in the content viewer - for example, full-screen
view or thumbnail (miniature) view

O Print shared pages, slides, or whiteboards in the content viewer

O Record an event

O0O0O0

(o)e]

e Polling Coordinators can prepare a poll questionnaire and conduct a poll during the event.

29. How do | use Polling during an Event?

Polling enables the Leader to utilize the operator to survey all conference participants. You determine the
questions prior to the conference and participants respond using their telephone keypads. Polling allows you to
collect instant feedback and increases participants’ involvement in the call. You receive a report with all
responses that is organized by question and participant. The poll coordinator is responsible for creating

and conducting the poll during the event. The host can assign the role of poll coordinator to a presenter or

a panelist.

How Do | Open a Poll
After you finish preparing a poll questionnaire, you can open the poll.
If you prepared your questionnaire in advance and saved it, you must first display it on the Polling panel.

In the event window, go to the View menu, then select Panels>Manage Panels....

The 'Manage Panels' window appears.

In the Available panels: section, select Polling, then click the Add >> button.

Click the OK button.

In the Question section in the Polling panel, select the type of question you would like to add, if the question
will have a single or multiple answer, then click the New button.

Note: You may open a previously saved poll by clicking the | button and selecting the poll.

¢ Type out your questions and answers. Repeat to add multiple questions to the poll.
e  Click the Open Poll button.
e The questionnaire appears on attendees' Polling panels. Attendees can now answer the poll.
e As attendees answer the questions, you can watch the polling status on your Polling panel.
Folling stabus
Not started _-:-_—2&3.5_?31____
B s i
Finished A-HEmEr | i these three butions.
Remaining tme: 454 Time limit 10:00
e Click Close Poll when the time is up.
e If you specify a timer and the poll times out, the poll automatically closes.
e Attendees can no longer answer questions.
e Once you close a poll, you can view the poll results and optionally share them with attendees.

Preparing a Poll Questionnaire - Presenter only

To conduct a poll, you must first create a poll questionnaire. You create a questionnaire in a meeting. To save
time during a meeting, you can start the meeting earlier than the scheduled time, create a questionnaire on the
Polling panel, save it, and then open it during the actual meeting.

This figure shows a portion of the Polling panel, which offers the tools you can use to create a questionnaire.
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Question

Type: ) Multiple choice Single Answer -

Answer

Shart answer

Mew

Record individual responses

Follow the steps below to create a questionnaire:
e Open the Polling panel in a meeting.

¢ Inthe Question section, select one of these question types:
o To create a multiple-answer question, select Multiple choice, and then select Multiple Answers in the
drop-down list.
o To create a single-answer question, select Multiple choice, and then select Single Answer in the drop-
down list.
o To create a text question, select Short answer.
e Click New.

¢ Type a question in the box that appears.

e In

the Answer section, click Add.

e Type an answer in the box that appears.
e To type another answer, click Add once you finish typing an answer.
e The question and answers appear in the Poll Questions area.

This figure shows an example of a poll questionnaire.

¥ Pelling X

Time elapsed: 0:46  Time limit:  5:00

Pall Questions:

ltest
as
b.f

e
dh

Submit

Your answer may be recorded,

Note:

30. How

The character limit for the polling question & answer fields are 250 characters.

do | end the Event?

The Host will End the Event by clicking on End Event under the File menu.
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Cisco WebEx Event Center
Edit Share View Communicate Participant Event Help

Open and Share... Ctrl+0

Open Poll Questions...
Open Chat...

Open Questions and Answers...

Close Crl+W

Save »
Save As >
Transfer... Ctrl+T

Print r
End Event

31. How can | obtain a list or Participants who joined my Event?

The link to your Reserved Net participant list can be found in the Reserved Net email confirmation. However you may

also follow the instructions below.

e Log into Manage My Meetings
e Usethe Leader Tools and Self Service Reports link

o Click Leader Tools in your Manage My Meetings account and select Self Service

Reports
Welcome EVA BE=ryus English v
b= Conferencing Chat Now B o
Home Manage My Meetings Leader Tools Product & Services Resources Contact Us
Conference Scheduling Assistant Meeting View Self Service Reports
IM Web Moderator Veerizon Collaboration Plug-ins Web RSVP Reports
Conferencing Reporting Net Conferencing Plug-ins e-Scheduling

Mobile Conference Connect IM Alert

Email Reservation Form

e Enter the Conference ID or Meeting Number and click Proceed

Conferencing Shat ow Bl

Home Manage My Meetings  Leader Tools  Product & Services  Resources  Contact Us

Self-Service Report
Conlact Us | Manage My Meetings | Conferencing Home
For Reserved Net Conferance. anter your Conferance ID. For instant Net Confarence, enter your subseription Maeting Numbes, then proceed

Conference ID or Mesting Number: ' |

|Emcent




e Choose Participant List Reports

Self-Service Reports
» Participants List Reports

View your participant lists from your Net Conference or for any Audio Web Streaming, Audio Web Replay or =
Net Replay meetings. Email, print or save these lists for your further analysis.

» Nat Conferencing Polling Reports

View all the polls in your Net C: with
dates and save the reports into Excel for your further analysis

; navigate through the

e Choose Net Conference and Click View Report

Participants List

Contact Us | Manage My leetings | Conferencing Home

Maote: You may format and analyze the entire data file by downloading the
’comma separated (CSV) file to your local application (e.g. Excel, Lotus

Notes) Select Report(s) To§ Download/Print your
i Display report

[] Net Conference Fl
Conference 1D 128 Help

[] Net Replay
Leader: ASHI [ view Report |
Date/Time: JUL-28-2013 04:00 PM ET

Duration: 30 mins

Choose the report(s) that you wish to view.
You may sort the entries by clicking on the column header.

e  Report will display the people who viewed your Net Conference.

Participants List

s | Manage My Mestings

Mote: You may format and analyze the entire data file by ing the To
comma separated (CSV) file to your local application (a.g. Excel, Lotus Display report
Hotes)

Conference ID 128

Leader: ASHE

Date/Time: JUL-28-2013 04:00 PM ET

Duration: 30 mins

You may sort the entries by clicking on the column header
Net Conference Total Participants: 5

mcruse Jisiw comwr —uns |~ owosonus

ASHE -UAT R VERIZON BUSINESS 07/28/201303:19PM &
ashe part R vzn 07/28/2013 03:20 PM
ashe pati2 R van 07/28/2013 03.21 PM
ashe pan3 R van 07/28/2013 03:23 PM
ashe pat3 R van 07/28/2013 03:42 PM
Grand Total. 5

Note: Participant list names will appear as entered by the participants when joining the conference.

32. How can | obtain a list of Viewers who viewed the Replay of my meeting?

e Log into Manage My Meetings
e Click Leader Tools in your Manage My Meetings account and select Self Service Reports
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Conferencing Chat How B

Home Manage My Meetings Leader Tools Product & Services Resources Contact Us

Conference Scheduling Assistant Meeting View Self Service Reporis

IM Web Moderator Verizon Collaboration Plug-ins ‘Web RSVP Reporis
‘Conferencing Reporting Net Conferencing Plug-ins e-Scheduling
Mobile Conference Connect 1M Alert

Email Reservation Form

BE= s English v
o

Enter the Conference ID or Meeting Number and click Proceed

Self-Service Report

Contact Us | Manage My Meetings | Conferencing Home

For Reserved Net Conference, enter your Conference ID. For Instant Met Conference, enter your
subscription Meeting Number, then proceed.

Conference ID or Meeting Number: | 128

e Choose Participant List Reports

Self-Service Reports
» Participants List Reporis

View your participant lists from your Net Conference or for any Audio Web Streaming, Audio Web Replay or =
Net Replay meatings. Email, print or save these lists for your further analysis.

» Net Conferencing Polling Reports

View all the polls in your Net C ; navigate through the

in you! with
dates and save the reports into Excel for your furtner analysis

e Choose Net Replay and Click View Report

Participants List
Contact Us | Manage My Meetings | Conferencing Home

MNote: You may format and analyze the entire data file by downloading the

’comma separated (CSV) file to your local application (e.g. Excel, Lotus Select Report(s) To
Notes). =
Display report
7] Met Conference ] [7
Conference ID 128 Help

Download/Print your

[ Met Replay

Date/Time: JUL-28-2013 04:00 PM ET
Duration: 30 mins

Choose the report(s) that you wish to view.
Y'ou may sort the entries by clicking on the column header.

e Report will display the people who viewed your Replay.




Contact Us | Manage My Meetings | Conferencing Home

Note: You may format and analyze the entire data file by downloading the comma separated (CSV) file to your local application (e.g
Excel. Lotus Motes)

Conference ID 128

Leader: ASHE

Date/Time: JUL-28.2013 04:00 PM ET

Duration: 30 mins

You may sort the entries by clicking on the column header.

Net Replay Total Participants: 1

ERSTMewe LASLMWE lcoueaw’ [IILE |~ ompapiue
Ashe R Vzn 07/29/2013 01:21 PM ai@b.com
Grand Total: 1

Note: Participant list names will appear as entered by the participants when joining the conference.
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